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Making your first Presentation begins on page 9. 
 
Copyright  
 The way this applies to Presentations, very briefly, is as follows.   
  
If you create something, and put it in a tangible form, it is automatically copyrighted. An image or a 
presentation is a fixed, tangible form, and therefore it is copyrighted. It helps if you note this on 
your material with the ©, and it helps if you register your material with the Copyright Office of the 
Library of Congress, but these steps are not required.   
  
Once created, no one can use your material without permission until their copyright or patent 
expires. Period.   
  
This also means you may not use other people's material in your presentation without their 
permission. Period.   
  
Some sites have notices, which state that you may use their drawings, etc.; this is their way of 
granting you permission. If this notice is not present, you must ask them. E-mail is usually is not 
considered legal permission, as there is no signature or proof of who sent it.   
  
Legal Gray Areas   
It is possible to get a picture of Mickey Mouse from sites aside from Disney, and while these 
'generous' sites may grant you permission to use their version of Mickey... they did not have 
permission in the first place, so them granting you permission to copy it to your site is useless. They 
are breaking the law, and you would be distributing illegal copies.  
  
It is possible to pull an image from Disney, and display it via the Internet in your presentation, which 
seems legal, as you are not storing the image. And, Disney had put it up there on the Internet 
already for people to look at... but this is theft of bandwidth, and the image is not being used as the 
copyright holders intended.   
  
Finally, copyrights do expire, normally 50 years after the death of the author, or 75 years after the 
item was released if the author is still alive.   
A U.S. utility patent is generally granted for 20 years from the date the patent application is filed. A 
design patent is generally granted protection for 14 years measured from the date the design patent 
is granted.  
http://www.stopfakes.gov/faqs/how-long-does-patent-trademark-or-copyright-protection-last  
    
How you can copyright something someone else made.  
Aside from being able to copyright the original, you can copyright your version, if you have 
permission to make your own version or if there is not copyright in place.  
Example: Barnes and Noble can copyright the Sherlock Holmes books that they publish, or the New 
York Philharmonic can copyright their performance of Beethoven's 9th Symphony, as they have the 
legal right to publish or perform the material since both original copyrights have expired. But again, 
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these new, legal expressions are now copyrighted... preventing you from photocopying a book, or 
copying a CD.  
 
You can make your own version of the Mona Lisa if you paint it from memory as the original is out of 
copyright; but if you use a photograph as your starting point, you are violating the copyright of the 
photographer.  
 
So, in this class,  
1) you must have created it yourself, or  
2) you must have written permission to use anyone else’s material (such as from Commons), or   
3) you must have legal permission to use the material, by way of fair use.  
  
Fair Use: A POSSIBLE exception to copyright law  
Fair use states that some work can be used without permission under a few rules:  
1) to parody a copyrighted work  
2) to critique or review a copyrighted work, only a small portion is used       
(a rule of thumb is 10% or less) and credit is given  
3) review a copyrighted work for scholarly purposes       
(again, only if a small portion is used and credit is given)  
 
PS You can’t claim your presentation on a game, mp3, or movie is scholarly.  
So let me repeat, in this class, to use something in your presentation,   
1) you must have created it yourself, or  
2) you must have written permission to use anyone else’s material, or   
3) you must have legal permission to use the material, by way of fair use.  
Check before using something you didn’t make. See also http://www.copyright.gov/   
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Notes on Versions of PowerPoint and the computers they run on 
If you get your email through Office 365, there is an online version of PowerPoint, but it is not 
suitable for this class. Note the difference in the interface between the online version home tab, and 
the full version, right below.  

 
Long story short, there quite a few more actions available in the full, or desktop version, and this in-
depth dive into PowerPoint does focus on the more advanced features. 
 
Note: You cannot use the desktop version on a Chromebook, only the online version, and again, the 
online version does not have all the tools that will be used in this course. 

However, the Mac version of PowerPoint works just like the Windows version, aside from the 
window controls, such as maximize/minimize, and close.

 

 

Getting Microsoft Office, other Presentation Graphics Software 
There are many other presentation graphics tools aside from PowerPoint, such as OpenOffice 
Impress, LibreOffice Impress, Google Docs, Adobe Persuasion, Harvard Graphics, and Apple Keynote. 

However, while similar in end product presentations, the tools are very different and often default 
to different file formats than PowerPoint uses. (You can often open a PowerPoint Presentation in 
these other tools, and often you can save as a PowerPoint file type, but the tool itself is different 
and not all the features line up. SO, for this class you need to either have  
1) access to the desktop version of PowerPoint installed on your computer,  
2) have access to a computer with the installed version, such as in a computer lab, or 
3) be able to figure out how accomplish the tasks using alternate software, and save your homework 
as a pptx. 

Your Learning Management System (LMS) may have instructions on how to get the desktop version 
for free, or for a reduced price.  

Typically, college users of Office 365 will have a link within the system to download the full version.  
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Log into your Office 365 account if you have one; on the main entry Window, note [Install Office]  

 

(If your school does have this feature, you can investigate the annual subscription options, though 
http://products.office.com/Microsoft/Office, where students can often buy Word, Excel, and 
PowerPoint outright for just a bit more than an annual subscription.) 

Presentation Basics  
Presentation graphics, such as PowerPoint can help people better understand what they hear, by 
adding visual reinforcement. Many people retain information according to the following rates: 
10% of what they read 
20% of what they hear 
30% of what they see 
70% of what they see and hear... 
... so by adding a PowerPoint show: you can increase retention, as well as helping yourself, by 
providing a guide to get through the presentation.  

For this class, you will use the following structure to reinforce audience retention: 
• Title Slide – Contains title of the presentation, Name of presenter including their title, 

organization, and perhaps a date.  
• Topics or Intro or Objectives - let them know what you will cover  
• Body of the Presentation – Contains slides of information for presentation, one main idea 

per slide. You may use graphs, pictures, etc. for clarity, or interest... if not over done!  
• Conclusion – Summarizes the presentation, and makes a point… what do you hope they 

learned. 
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Design Consideration Basics, monitor vs. projection, on site or away 
Assume you will be presenting to a big room; make sure the audience members in the last row can 
see the presentation text. 

If the presentation is to be displayed on a screen, especially in a poorly lit room with a weak 
projector, use a dark background with contrasting light text. 
If the presentation is meant to be displayed on a user’s computer, you may consider using a light 
background with contrasting dark text, but if you are unsure of the final delivery location, use a dark 
background. 

Avoid the color red for text, or backgrounds, it does not project well. 

For that last row audience member, strongly consider the 7x7 rule. This rule states that there should 
be no more than 7 words per line, and no more than 7 lines per slide. PowerPoint by default uses 
fonts that I think are already too small, and if you put too much text on the slide, PowerPoint further 
reduces the size of the text.  

You really never should put full sentences or paragraphs of text in a presentation… the presentation 
is to support the speaker, not to deliver all the content. Bulleted lists should be what is on the 
screen, and the speaker should provide the narrative. Additional handouts can be the 
reinforcement. 

Steve jobs famously would occasionally put just one word on a slide, to make a point. 

I strongly suggest making the title font size 40-44, and the top level bullet size 36-40. Further, while 
serifs can benefit a printed document to add clarity, a projected word at a distance loses the benefit 
of the serif, so typically you should choose a well-designed proportionally spaced san-serif font for 
projection. 

A little bit about text shapes on computers, usually called fonts. This includes the  
font face, or, the shape of a letter and if it has got extra shapes to help you read it (called serif) 
or no extra shapes (called san serif) A serif 'g' is a lot less likely to be read as a 'q' than a Sans 
serif version .  
Consider lll, is that the word ILL, or an uppercase i, a lowercase L, and a number 1? 
The font size of the letter, measured in points... 72 points in an inch 
The font color of the letter 
The attributes of a letter, such as bold and/or italic. 
Another consideration is the spacing of letters, if it is monospace, or proportionally spaced. 
Monospace letters all take up the same amount of room, where as proportional take less space 

Monospace words can be harder to read because of spacing. 
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Every slide should have a title, and should cover one main idea. Typically the overview slide lays 
out the titles of slide to follow. If the one main idea does not fit on one slide, make a second slide 
with the same title to continue. 

Avoid overwhelming animation or transitions. A transition is how the slide appears, animation is 
how the contents of the slide come in. If overdone, this can be a distraction from you message.  

Bad example 1: I saw a presentation where the presentation text came in a letter at a time, with a 
typewriter sound… it literally took 2 minutes for all the text to appear, and the audience had 
stopped paying attention. 

Bad example 2: I saw a presentation where both the animations and transitions were set to 
random… you should never be surprised by what is going on, on the screen behind you. After a 
while, the audience seemed more interested in how the text would appear than with what the text 
said. 

Bad example 3: I saw a presentation where each slide had a different colored background, different 
sizes and colors of text. Items would zoom in and out… Other people told me later they actually felt 
sea sick, and were so turned off by the delivery that they did not recall the message. 

To avoid overwhelming, stick with two acronyms: CCC and KIS. 
CCC: Clutter Creates Confusion 
KIS: Keep It Simple. 
 
When appropriate you should add a graphic; as the saying goes, a picture can be worth a thousand 
words. But 17 pictures on the same slide? Probably not improving your message.  

Guy Kawasaki1 preaches the 10x20x30 rule: no more than 10 slides, the presentation should be a 
maximum 20 minutes, and no font should be smaller than 30 points.  

Most people can recall 7-10 items; more than that you they may not recall some very important 
topic.  

Most people have a 7 minute attention span, so unless you are very good at bringing people’s 
attention back, even a 20 minute presentation can be a reach. Leave time for questions to fill your 
allotted time. 

How not to present: Don’t read the presentation; practice the presentation until you only need to 
occasionally refer to notes. Practice in front of a mirror, and time yourself. 

Failure to practice often leads to one of two problems: 
fumbling through the presentation, and losing your way (which leads to losing your audience), or  
rushing through the presentation, which does not allow the audience time to digest what was said. 

Don’t speak to the screen, make eye contact with your audience, or at least look like you are making 
eye contact with the audience. Scan the room looking above the faces if eye contact makes you 

                                                             
1 https://guykawasaki.com/the_102030_rule/ 
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uncomfortable. Find a clock and make sure you are sticking to you pace. Put your watch or phone on 
the podium where you can see it. 

Assume it will not work. Have a plan B. Do you have a copy of the presentation on a thumb drive, in 
case the one you emailed doesn’t get put on the computer in the room? Did you embed the video in 
the presentation, in case there is not a working internet connection? Did you save it as a ppsx as 
well, in case their version of PowerPoint is too old to show your new file? 

But you do have to deal with Implications of these actions, especially file size, and potential 
copyright issues. 

Picasso’s rule. Finally, Picasso’s rule… if you know all the rules, sometimes it is okay to break the 
rules. Picasso know how to paint realistic people and scenes, he chose to make simplistic images on 
occasion to better tell his story. 

If you are working with a specialized crowd, trying to make a particular point, or if you think it will 
aid you to tell a better tell a story, etc., break a rule or two. But you have to prove you can follow 
the rules before you can start breaking the rules, especially in this class. 

“As the maxim goes, rules are for the guidance of wise men and the obedience of fools. Break all of 
these rules at once and don’t blame us if you end up with a screen full of spaghetti. Bend them in 
isolation, however, and beautiful things can happen.” 2   

 

                                                             
2 https://buffalo7.co.uk/three-powerpoint-presentation-design-rules-can-break/ 
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Your First PowerPoint 
Recreate the following Presentation: Making a burger 

Begin by opening PowerPoint; In Windows select  Start and browse the listing, or click in the 
Search bar typing PowerPoint... when located, select the icon 

 

 

Select Blank Presentation, to get the following screen 
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I prefer to keep my hands on the keyboard, and to maximize my time. Rather than using the 
standard view, I prefer Outline view.  

Next to the lightbulb icon  at the top right, you may type Outline view, or  

click the Normal view icon at the bottom of the screen twice. 

 

Click next to the small box in the upper left hand window, and start typing... what you type here 
shows up in the main window. 
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In outline view, you may leave your hands on the keyboard, and not have to reach for the mouse.  
Three rules: 
At the end of each line, you press the enter key, and it stays at that level of the outline.  
If you wish to increase the indent into the outline , press [Tab].  
If you wish to decrease the indent of the outline , press [Shift]+[Tab].  

Yes there are icons to increase and decrease the indent, but that can interfere with your train of 
thought when trying to quickly created your presentation. 

 

You should always start your presentation with a slide that lets folks know who you are and what 
you are covering. 

Professions typically are making an assertion that they will support... in our simple presentation 
we'll just have a meaningful title. 

To duplicate what I have so far, again click next to the 1[] top left, and type: My First Presentation.  

Of course, a better title would actually tell the people what the presentation was going to be 
about. Use your arrow keys, and move to get back to the beginning of the My First Presentation line. 
Just as Word can edit text, PowerPoint can to; replace the My First Presentation text with Making a 
Burger. Press the [Enter] key, then the [Tab] key, to increase the indent… then type your name. You 
should see a preview similar to the image above.  

Hit the enter key to start a new line.  
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We don’t want to be at this level any longer, so to decrease the indent of the outline , press 
[Shift]+Tab]. This should create a new slide. 

Note: when at the highest level, pressing the [Enter] key automatically inserts a new slide, using the 
default type: Title and Text (with bullets). You may also choose other types of slides by clicking the 
New Slide button. 

A normal outline looks like this: 

I. Major topic 
   a. subtopic 
   b. subtopic 
      i. detail 
      ii. detail 
II Next topic 
   a. sub topic 
      i. detail 
and so on.  

In Word, when using an outline number list, or when in PowerPoint's outline view, 
[Enter] starts a new entry at the same level you are on 
[Tab] moves the current entry 'right' one level, such as from major topic to subtopic. 
[Shift] [Tab] moves the current line left, such as from subtopic to major topic. 
 
(You may also use the New Slide button, or the increase and decrease buttons on the Home tab.) 

 

So if you are at the slide level, [Enter] makes a new slide, and [Tab] moves from major topic to 
subtopic, etc. 

Make sure your cursor is in the outline, next to 2[].  

This will be our overview slide, which briefly describes everything you want to present. 

Some folks think of this as the mapping slide... which shows how the presentation will progress; at 
any point you need to let the audience know what you going to discuss, to prepare them to better 
retain the material. 

For this simple presentation, type Overview to add a title to the slide.  

Press the [Enter] key, then the [Tab] key to move from the title to the bulleted list, then type  
Get a bun. Press the [Enter] key. 

This moves the next line of the bulleted list. Now type Cook Patty. This creates a new entry at the 
same level. Press the [Enter] key, to start a new line, and then type by Put Patty on Bun.  

This would be a good time to save your presentation, perhaps calling it yourname-test.pptx. 
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This is what you should have, so far. 

 

We are now ready for slide 3. As always, at the end of a line, click Enter. 

There are several ways to lay out slides, but it is important to limit each slide to one main idea, and 
not overload it with text. Some folks use a slide with an assertion related to the first topic, a graphic 
that lays items to be discussed, and will identify key assumptions at the bottom. 

In this simple presentation, we'll use talking points. 

Make slide 3 look like: 

Get a bun 
  Open Package 
  Take out bun 
  Put bun on plate 
Notice that we took our major topic from the overview slide, and just added details. 

Make slide 4 look like: 

Cook Patty 
  Open Package 
  Take out patty 
  Put in Microwave 
      Follow cooking instructions 
 
Make slide 5 look like: 

Put Patty on Bun 
  Using a spatula, remove patty 
  Place patty on bun 
  Add lettuce and catsup 
       Add additional items to taste 
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At the end of your presentation, you need a summary... perhaps remind them of the key points you 
made, and the deliver what you hope they learned. Again, it could be a summary statement, a 
graphic that puts it all together, and perhaps a request for questions, but again, we will be using 
talking points in this simple presentation. Make slide 6 look like: 

Conclusion 
 Follow 3 simple steps 
    Get a bun 
    Cook patty 
    Put patty on bun 
Making Burgers is easy 
Enjoy! 
  *unless you have high cholesterol 

The top part is the recap 
 
 
 
 
This part is the conclusion. 
PS this part is a really BAD conclusion 
in the future you should do better 

Additional sound effects, movies, pictures, etc. can be added from the Insert menu. More on this later. 

The next step is to know where the presentation is to be delivered, and make sure you lay your 
presentation out so you entire audience can read it as you discuss it. For this presentation we are 
going to make some assumptions: 
1) you have the typical lousy projector, lights have to be dimmed for folks to see what you have, and  
2) it is a deep room with some folks fairly far away from you. 

To deal with these two issues, we will use a dark background with light text for contrast, and big, 
easy to read fonts. Choose the Design tab, and select a theme. Experiment with some samples, I like 
Damask, but none are really good.  
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Selecting Damask.

  

Return to the Home tab. 
Now, let's run the presentation. Press [F5] to start from the beginning, or click 
the presentation icon in the lower corner to start the presentation from the 
current slide.  

 
Okay, not bad, but a little boring. And, the font is too small. So, on the View tab, click Slide Master... 
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...and select the Title and Content slide... the one below the title. 

 
Highlight the text in the big box;  

 
… select the Home tab, and increase the size of all the text items by clicking the [A^] button... I like 
the first line font size to be between 36 and 40.  

Now the text can be read from the back of an auditorium. Click Slide Master and close the tab. 
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Now let's change to Slide sorter view. In the lower left hand corner, choose the four box icon. 

  
From here, you may right click and hide a slide, or drag a slide from one place to another, or apply 
transitions. Select a slide or slides, then on the Transitions tab, choose a transition. I like Fade  

 
As with Word, in order to add images, you use Insert/Image/from ClipArt... to add a picture of a 
hamburger on the first or last slide, double click the slide to go back to the Outline view for that 
slide, then insert an image. Note, you may select Commons images that you are free to use. 

Additional tricks can be done with custom animation. Go to the last slide, making sure you are in 
normal outline view; click the text box, you should a box with dashed lines... 

THEN choose the Animation tab, and select Appear. 

This will bring in items a paragraph at a time, instead of all at once. 
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Note for academic presentations, you also need to include your references... making a burger does 
not require these citations. 

Finally, when printing, you may print slides, handouts, or notes. If printing handouts, I choose 6 
slides per page, and print in Pure Black and White for the best results. 

 
Save your presentation as yourname-test.pptx 
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Module 2 
What’s New in PowerPoint 2019? 
Dec 31, 2018 |https://www.presentationpoint.com/blog/whats-new-in-powerpoint-2019/ 

 
What’s new in PowerPoint 2019? A lot. 
Microsoft’s PowerPoint is no doubt one of the most versatile and most used Office applications. 
From helping people organize charts, statistics, data and information, to helping presenters pass 
information to an audience in the simplest and most visually appealing way, everybody at one point 
will make use of the PowerPoint. 

There are more than 500 million PowerPoint users with over 300 million presentations created per 
day, using the application. 

However, from 1984 (when the first application was rolled out) until now, a lot has changed about 
the features—and target—of the app. For one, it was initially made for “managers, professionals, 
knowledge workers, and salespeople”. Now the application is for everybody. 

And while the basic functions of organizing presentations are still in use, a lot of features have been 
improved upon. 

The previous version was Office 2016 and next to this traditional version, Microsoft started with 
their Office 365 subscription-based version. Regularly, they added new features to the Office 365 
edition like the text highlighter, Morph transitions and more. Basically, this new Office 2019 is the 
sum of Office 2016 plus all the new features of Office 365. 

Here are the latest features in PowerPoint 2019: 

Enter the text highlighter 
If you have used this feature in Microsoft Word, it is not so different in PowerPoint 2019. Found 
under the Home tab (and under fonts), the text highlighter allows you to emphasize important texts 
by changing the color around the text. 

https://www.presentationpoint.com/blog/whats-new-in-powerpoint-2019/
https://www.bbc.com/capital/story/20180125-our-love-hate-relationship-with-powerpoint
https://www.bbc.com/capital/story/20180125-our-love-hate-relationship-with-powerpoint
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Funnel Charts 
A powerful way to depict trends, funnel charts can help show how data has increased or decreased 
across various dependent stages. Generally, they are called funnel charts because the value 
decrease and the shape look like a funnel. 

Tip: if you are an Excel user, this option is also available. 

Transition Morph 
Transitions are one of the interesting features of PowerPoint. You might be used to effects 
like Honeycomb, Fade, Zoom, Random, Origami, Gallery and so on. If you are, you will love the newly 
introduced Morph effect. 

Tip: It is placed after the Normal effect and before the Fade effect so that you can locate it easily. 

Basically, the morph effect is used to animate or make your slides or objects move as if they have 
life within them. It can make your objects bigger from the background and you can specify what you 
want to animate. 

To make use of the morph effect, you will need to duplicate the slide you want to morph. Click on 
the transitions tab and apply the morph to the duplicate slide or object. Afterward, click on the 
preview to see if you like what you did. 

 

The Zoom 
Zooming has always been a great feature to have around. Not only for PowerPoint presentations but 
for everything else.   

The new Zoom effect in PowerPoint 2019 is another great way to emphasize presentations. You can 
see more than one—or all—of your slides at a glance and choose which one you want to discuss or 
present. 
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With the Zoom for PowerPoint 2019, you can jump from a slide or section to another slide or section 
of your presentation. 

The zoom tab has three commands which you can choose from to bring out various interesting 
effects. 

The summary zoom 

The Section zoom 

The Slide zoom 

Remove Image Background… easily 
With this new version of PowerPoint, you can easily remove the background of an image. The auto-
detect feature removes the need to draw around the shape you want to keep in the foreground. 
More still, you can draw with pencil in free-form instead of using straight lines only—a limitation 
found in previous versions. 

Insert Icons and 3D models 
If you have 3D models you want to insert, click on the insert tab and on 3D models to choose “from 
a file”. 

If you don’t have 3D models available, but you intend to insert one, you can choose “from online 
sources”. As part of the update, there is a large online library called Remix 3D, on which you can 
search through for different models. 

After you insert, you have options to manipulate the image. You can: 

Tilt the image in any direction or position 

Make the image smaller or bigger 

Rotate the image 

Align the model on the page or slide 

Pan and zoom the model to make it fit within the frame 

Use the morph transition to rotate or zoom the 3D model 

You can also insert Scalable Vector Graphics or SVG images. You have options to edit the color and 
texture; add effects like shadows, glow or reflection; and align, rotate, crop or zoom the image. 

Interestingly, you can also covert the SVG image into shape and edit the parts independently. Simply 
right-click the SVG image and click on convert to shape. 
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Add an Online Video 
Mac users can add a live or online video to their slides without leaving the presentation. Here is 
how: 

Go to YouTube or Vimeo 

Look for the video you want to make use of. 

Right under the video frame, click on Share, and click on Embed. (If you don’t click on Embed, you 
will end up copying the wrong code) 

Copy the iFrame embed code. (The code MUST not begin with “https”. It does, click on Embed again) 

Go back to your PowerPoint presentation. 

Click the slide in which you want to add the video. 

Click on the Insert tab and on “Video”. Afterward, click on “Online Video”. 

In the “From a Video Embed Code box”, paste the embed code you copied, and then click the arrow. 

You will see a video rectangle that you can move and resize to suit your needs. Preview the video. 

You can also search for the YouTube video by name and insert into your slides. 

Also, you can trim or cut out parts of a video that you don’t want. This option is available only for 
videos that you have inserted from your computer and is available for both Windows and Mac users, 
although Mac users need to be on Office 365. 

You can also trim audio files and discard parts that you do not need. 



PowerPoint Module 1 p. 23 

Convert to High Quality Videos 
After saving your presentation in .pptx, you can export the file and convert it into a video format. 
The 2016 PowerPoint version allows you to do this. However, in PowerPoint 2019, you can export 
your video as an Ultra High Definition (HD) or 4K format which you can display on large screens. 

You can also save your presentation as a PowerPoint show (.ppsx), such that when people open the 
file, it displays in full-screen and presentation mode. They begin to see your presentation 
immediately. 

 

Digital Control 
If you have a Surface Pen 4 or any digital pen that supports Bluetooth connectivity, you can control 
your slides and advance them. 

Copyright Release 
Dear Sir,  
Thanks for your message. Sure no problem with that. You can collect all the information from our 
websites www.presentationpoint.com and www.signagetube.com, and present it to your students. 
Let me know if you need more info on data-driven presentations or digital signage! 
Best regards / Met vriendelijke groeten, 
Kurt Dupont 

 
 

 
 

 

https://nam11.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww.presentationpoint.com&data=02%7C01%7Ccraig.collins%40templejc.edu%7Cf3b23b6ca7db4af52cf808d7426a548d%7C73485353c20f424298b730edf6b8e7ec%7C1%7C0%7C637050896775077505&sdata=ODebtQmChCG%2FNv0rU9LPwRfMQXPQdaYWR5kj4Kl4HZA%3D&reserved=0
https://nam11.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww.signagetube.com&data=02%7C01%7Ccraig.collins%40templejc.edu%7Cf3b23b6ca7db4af52cf808d7426a548d%7C73485353c20f424298b730edf6b8e7ec%7C1%7C0%7C637050896775087503&sdata=iuO%2ForSvMZ%2FkVzvIzoRNMaZzQbLi66Mcr7gKoGv%2BPrA%3D&reserved=0
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